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Welcome

• Welcome to the Production Reporting Course for customers using the 
REAL/Easy BOS® or the REAL/Easy Database. 

• In this course you will learn how to create and modify management 
reports that can help you track and analyze your company’s performance.

• The program used to create the reports is called Crystal Reports. It is a 
popular report writing program that can be used create custom production 
reports for your company. 

• Because the BOS system also uses Crystal Report programs for it’s 
standard reports, BOS users will also learn how to modify these as well.

• For customers using the REAL/Easy database you will learn best practices 
for developing your own reports as well as utilizing reports from the 
Executive and Operations Reports Warehouses. 
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Introduction

REAL/Easy BOS is the system used to maintain the agent, listing and sales information 

We will learn to write reports that access BOS data for three areas: 
• agent rosters, 
• listing production, 
• and sales production

We will learn how to use Crystal Reports to modify and build reports in the above 3 areas 
accessing data maintained by BOS. Report names are:

• branchagentrosterbyName.rpt
• branchranklistwrittenbyunits.rpt
• branchranksaleswrittenbyAGCI.rpt
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Introduction: Agent Roster

Selections?   Sorted by?
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Introduction: Agent Roster

• All reports access certain data from the BOS database. Here is a typical agent roster 
report and it is displaying agent information.

• Most reports select data from the database. In this case, the roster is only to include 
agents who are active. This is illustrated with the “Status” column. 

• Select: The report is only to include records from the database that are Agents. In 
BOS, the database contains information for either Agents or Employees. So for the 
agent roster, the record type of “AGENT” is selected as illustrated with the “A/E”
column.

• Further, reports also sort, or order, the data in some way. Above, the records are 
sorted by the agent’s last name.

• The sample Crystal report name is: branchagentrosterbyname.rpt
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Introduction: Listing Production

Selections?   Sorted by?
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Introduction: Listing Production

• Above is a sample listing production ranking report.
• The listing database in BOS contains information for all listings no matter 

when they were written or what their status.
• The report above makes two key selections, what are they?

1._________________
2._________________

• Further, the report is sorted a certain way, what is it? _______________
• When learning about how to create listing production reports from BOS, 

you will learn that some items on the report are obtained directly from data 
stored in the BOS database. Listing units, for example, is stored in the 
database. 

• Other items you want may need to be calculated from fields stored in the 
database. An example of this is the agent’s “Volume” figure - it is 
calculated from other items stored in the BOS database.

• The Crystal report name is: branchlistwrittenbyunits.rpt



© Executive Systems - Production Reporting Course using Crystal Reports® 8

Introduction: Sales Production

Selections?   Sorted by?
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Introduction: Sales Production

• Above is a sales production ranking report. Many figures are included from GGI down 
to Company Dollar as well as units and volume awarded. 

• What are the two key selections made by this report?
1. ______________________
2. ______________________

• How is the report sorted? ___________________________
• When building sales production reports from BOS data, you will learn that some of 

the financial and award data is stored in the BOS database and others need to be 
calculated. For example, the Agent Gross (earnings) is stored in the database but 
Company Dollar is calculated. This will be covered in detail later.

• The Crystal report name is: branchranksaleswrittenbyAGCI.rpt
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Course Outline

1. About Key BOS data Tables
2. How to Modify Agent Roster Reports
3. How to Modify Listing Production Reports
4. How to Modify Sales Production Reports
5. How to Build New Reports
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1. About Key BOS Tables

• Databases are used by BOS to store groups of related information.

• Each database is consists of a number of Tables - e.g. an “agent”
table is in each database for storing agent names and other agent 
information

• Reports are written utilize a certain table or tables - e.g. to write an 
agent roster by name report we would use the agent table

Database Table

Table

Table



© Executive Systems - Production Reporting Course using Crystal Reports® 12

1. About Key BOS Tables

Field

Field

Field

Field

Field

Field

Field

Field

Field

Field

Field

Field

Table

Database

Tables are made up of records of pieces of information called fields - e.g. in the agent 
table, fields might be name, address, phone number. For each agent entered into an 
agent table there is a record in that table. If you have entered 25 agents, that means 
you have 25 records in the agent table.

When you print, select, and sort data, you are really doing this with the fields that are 
within records that makeup the tables.

record
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1. About Key BOS Tables

There are a number of BOS databases. Of all of these, there are four key 
databases. We will learn about their content and how to build reports that 

access their tables and fields.

• The AGENTS database mainly contains the agent and employee information 
entered in BOS.

• The COMMON database has many tables. Most are setup, or Preference, tables
such as the property types.

• The FRONTOFFICE database also has many tables. The key tables we will deal 
with are those containing the listing information.

• The BACKOFFICE database is the largest in the BOS system. Here transaction 
information is maintained.
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1. Key BOS Databases and Tables

COMMON.mdb:
OFFICES
PROJECTS
PROPERTYTYPE
FINANCETYPE
BUYERSOURCE
SELLERSOURCE
SOURCEOFBUSINESS

AGENTS.mdb:
AGENTS

FRONTOFFICE.mdb:
LISTINGS

LISTINGAGENTS
LISTINGCONTACTS

BACKOFFICE.mdb:
TRADE

COMMISSIONS
TRADECONTACT
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1. Key BOS Databases and Tables

The key tables within each database is listed above. While each database has many more tables 
than we list here, we are concerned with the above tables for production reporting.

• For AGENTS, we note only the AGENTS (same name) table. It contains agent and 
employee information that is entered in the BOS Setup module.

• For the COMMON we note seven tables:
– OFFICES contains the office codes and names entered in BOS Setup and assigned to agents, listings, and transactions..
– PROJECTS contains the project codes and descriptions entered in BOS Setup.
– PROPERTYTYPE contains the property type codes assigned by BOS and the user descriptions entered in BOS Preferences 

and assigned to transactions.
– BUYERSOURCE contains the source ID code assigned by BOS and the descriptions you entered in BOS Preferences and 

assigned to transactions.
– SELLERSOURCE contains the source ID code assigned by BOS and the descriptions you entered in BOS Preferences and 

assigned to transactions.
– SOURCE OF BUSINESS is the source descriptions entered in BOS Preferences and assigned to seller and buyer contacts.

• For the FRONTOFFICE database, we will work with these tables:
– LISTINGS contains address, price, and other key information for each listing you enter in BOS Listings module.
– LISTINGAGENTS has a many-to-one relationship with LISTINGS and contains one record for each listing agent of a listing.
– LISTINGCONTACTS has a many-to-one relationship with LISTINGS and contains one record for each seller name for a listing.

• For the BACKOFFICE database, we will work with these tables:
– TRADE contains address, price, and other key information for each sale you enter in BOS Transactions module.
– COMMISSIONS has a many-to-one relationship with TRADE and contains one record for each commission payee for a 

transaction.
– TRADECONTACT has a many-to-one relationship with TRADE and contains one record for each seller name, buyer name and 

other contact name for a transaction.
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1. Agents Database, Agents Table
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1. Agents Database, Agents Table

Users of BOS are familiar with the agent information screen above left. At the right side is the field 
layout of the Agents database’s Agent table. Most of the fields are named so that you can easily 
ascertain their contents. Tables generally contain numeric, alphabetical (or alphanumeric), dollar, 
and date field types. Some of the fields are needed to identify the records and others contain 
formation relating to the record.

In naming the table fields, the BOS authors used prefixes to indicate the field type. “sz” is used to 
indicate a alphabetical or “string” field, the “dt” prefix for “date” fields, “d” prefix for “dollar and 
cent” or “decimal” fields, and “I” for integer (number) fields. 

We note these key fields within the Agents table (red arrows above):
• The agent code, szAgentCode, is a unique id that you assign to each agent. It is alphanumeric.
• The agent report name, szName
• The agent’s start date, dtStart
• If terminated, the agent’s termination date, dtTermination
• The agent’s office, iOfficeID (is alphanumeric, e.g. “OFFICE1”)
• The agent status, szStatus (ACTIVE or TERMINATED)
• The Agent table record type, szType (AGENT or EMPLOYEE)
• The last name, szLastName
• The first name, szFirstName
• The display name used for lookup tables, szDisplayName
• The full or part time indication, szFullPartTime
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1. FRONTOFFICE Database, LISTINGS Table
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1. FRONTOFFICE Database, LISTINGS Table

For each listing entered in BOS there is a LISTINGS table record. The key 
entry screen for the BOS listing information is shown above. Key fields are 
shown to the right include:

• the FOS list number, used to identify the listing, is szListingID
• the Office assigned to the listing is szOfficeCode (e.g. “OFFICE2”)
• the MLS number is stored in field szMLS1. (there is also a second MLS 

number).
• The listing’s status is within szStatus (e.g. “Active”, “Pending”, “Sold” )
• current list price: szCurrentListPrice
• listing taken date: dtListDate
• list of list side agents: szAgents
• the listing property type: szPropertyType (e.g. “Residential”)
• source of the seller: szSellerSource
• an important BOS system assigned field, iListingIndex, is used by BOS to 

uniquely identify the listing records. This field is important as it is used to 
“join” to other tables with listing information.
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1. FRONTOFFICE Database, ListingAgents Table
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1. FRONTOFFICE Database, ListingAgents Table

• For each listing agent entered for a listing there is a record stored in the 
ListingAgents table. There would be two records in this table on a split 
listing where each agent has 1/2 of the listing. 

• As illustrated above, the agents are entered using the “Agents” tab of the 
listing entry windows. 

• The unique identifier that ties the records in this table to the Listings table 
is the iListingIndex field.

• The agent ID code: szAgentCode (this is the same as the AGENTS table 
szAgentCode field).

• The list side units: dListUnits
• for convenience for report writers, many fields from the AGENTS table are 

copied into the ListingAgents table. These include the agent report name, 
szDisplayName. 
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1. FRONTOFFICE Database, ListingContacts Table
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1. FRONTOFFICE Database, ListingContacts Table

Seller names and other contacts for each listing are stored in the 
ListingContacts table within the FrontOffice database. 

For each seller entered on the listing entry screen’s “Contacts” tab, 
there is a ListingContacts record.

Key fields include:
• iListingIndex is the field that links this table to the Listings table.
• The contact type, e.g. “Seller”, is stored in the szContactType

field.
• The source of the contact is stored in the szSourceOfBusiness

field.
• If you are assigning the contacts to agents, the agent’s ID code is 

stored in the szAgentCodeSource field.
• If assigning contacts to offices, the Office ID code is stored in the 

szOfficeCode field.
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1. BACKOFFICE Database, TRADE Table
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1. BACKOFFICE Database, TRADE Table

• For each BOS transaction, a record is stored within the 
BACKOFFICE database’s TRADE table. 

• BOS entry screens are shown above with most key 
information entered on the “Property” tab. This includes 
the property address, transaction ID, sale price, status, and 
important dates.

• The “Demographics” tab is used for sources and financing 
and the custom fields. 

• And the “Other Selling Broker Listing Broker” tab is used to 
enter co-op broker details.



© Executive Systems - Production Reporting Course using Crystal Reports® 26

1. BACKOFFICE Database, TRADE Table
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1. BACKOFFICE Database, TRADE Table

The TRADE record is quite lengthy. The key fields are indicated above with red arrows. 

• iTransactionID is the system assigned numeric transaction ID or BOS ID. This is a unique number 
used by the BOS system to identify each TRADE record and to link to other tables having other 
transaction information - e.g. COMMISSIONS and TRADECONTACT.

• iOfficeID, though not used for production reports, is the main office ID (e.g. OFFICE2).
• iProjectID, is the project (if any) assigned to the transaction. This is a numeric code assigned when 

the data entry user selects the project description from the PROJECTS table.
• iTransactionStatusID, is a code that indicates the transaction’s status. (“3”=closed, “4”=pending, 

“5”=cancelled, “2”=firm, “6”=backup offer).
• dtPending: the transaction pending date (also called “open”, “Sale” or “offer accepted” date).
• dtClosing: the transaction close date
• iSellerSourceID, is the seller source assigned to the transaction. This is a numeric code assigned 

when the data entry user selects the seller source description from the Seller Source table.
• iBuyerSourceID, is the buyer source assigned to the transaction. This is a numeric code assigned 

when data entry selects the buyer source description from the Buyer Source table.
• iFinanceTypeID, is the financing method assigned to the transaction. This is a numeric code 

assigned when data entry selects the financing description from the FINANCETYPE table.
• szTranType: the transaction type (“FL-FS”, “FL-CS”, “CL-FS”)
• szRealEasyID: an alternate transaction ID and, if converted from REAL/Easy, that tran ID. 
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1. BACKOFFICE Database, Commissions Table
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1. BACKOFFICE Database, Commissions Table

The key table used for sales production reporting is the Commissions table. For every row entered 
within the transaction entry “Commissions” tab, there is a Commission table record. This includes 
all green (income) and white (fees and commission expenses). 

Shown above is a sample agent commission entry screen. It has two tabs: the “Commission Worksheet”
and the “Allocated Gross For Commission Plans”. Some of the key fields used for reporting are 
indicated with the red arrows in the above record field layout: 

• iCommissionID is a unique BOS system ID assigned to each record
• iTypeID is a numeric code that indicates the record type (e.g. 35 = and agent commission record). 

All id types are listed later.
• iTransactionID is the numeric BOS transaction ID that ties the Commission table records to the 

TRADE records. 
• dListComm: the agent gross list side earnings
• dSellComm: the agent gross sell side earnings
• szRoleID is a string field that defines the role selected for the income or commission in the record 

(e.g. “list side” or “Office GCI” or “Referral”).
• dListUnits: the list units (sides, legs) awarded to the agent.
• dSellUnits: the sell units (sides, legs) awarded to the agent.
• dListVolume: list side volume awarded to the agent.
• dSellVolume: sell side volume awarded to the agent.
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1. BACKOFFICE Database, TradeContact Table
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1. BACKOFFICE Database, TradeContact Table

Sellers and Buyers, title and mortgage companies, and other contacts 
important to track for each transaction are entered within the transaction 
screen “Contacts” tab. For each contact, a record is stored in the 
TradeContact table. 

• iTransactionID is the numeric BOS assigned transaction code tying each 
TradeContact record to the TRADE record. 

• szContactType stores the contact type, e.g. “Seller”, “Buyer”, “Title 
Company”.

• szSourceofBusiness stores the source of the contact. This is string field 
and the value is selected by the data entry person from the 
SOURCEOFBUSINESS table setup in Preferences.

• If assigning agents to contacts, the Agent’s ID is stored in the 
szAgentCodeSource field.

• And, if assigning contacts to an office, the office id is in the szOfficeCode
field (note Office names are in the Offices table of the Common database).
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2. How to Modify Agent Roster Reports

COMMON:
OFFICES
PROJECTS
PROPERTYTYPE

BUYERSOURCE
SELLERSOURCE
SOURCEOFBUSINESS

AGENTS:
AGENTS

FRONTOFFICE:
LISTINGS

LISTINGAGENTS
LISTINGCONTACTS

BACKOFFICE:
TRADE

COMMISSIONS
TRADECONTACT
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2. How to Modify Agent Roster Reports

• Modifying Reports: The agent roster reports access the Agents database Agents
table. In the next few pages we will walk through using Crystal Reports for agent 
rosters or lists. However, the Agents table can also assist with production reporting.

• The key production tables are the FRONTOFFICE database’s LISTINGAGENTS table 
and the BACKOFFICE database’s COMMISSIONS table. 

• Often, reports will need to access both the production table and the Agents table for 
selections and sorting. 

• For example, if you wish to have a production report for only agents who are active, 
that you need to join the Agent table to the production table so the selection can be 
made on the Agent table’s szStatus field. 

• Or you may want to run a production report on newly hired agents. Again, the Agent 
table would be joined to the production table so that the selection expert would select 
on the Agent.dtStart field. 

• Further, if you want any report to sort on the agent last name, you would again join to 
the Agent table and with the sort expert sort the szLastName field. 
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2. Agent Roster: Crystal Reports Designer
Select Expert Sort Expert

Preview

Designer

Sections
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2. Agent Roster: Crystal Reports Designer

• The Crystal Reports Designer is used to modify and build reports that 
access the BOS data. The general appearance of a report within the 
designer is illustrated above with a agent roster report named: 
branchagentrosterbyName. The report name is in the title bar.

• Tools include the “selection expert” (hand) to setup record selection 
criteria (e.g. szStatus = “Active” agents) and the “sort expert” (A->Z) to 
define how to sort the records (e.g. szLastName).

• The report is divided into sections or groups starting with the Report 
Header. Here, the various report text headings and fields are placed to 
create the report. All reports have at least a report header and footer and a 
“Details” section.
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2. Agent Roster: Database Visual Linking

Menu commands and 
tools are used to 
construct and change 
and save the reports.

To view the tables 
accessed by the report 
for example, you would 
click on the “Database”
menu option and, from 
the drop down, click the 
“Visual Linking Expert”
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2. Agent Roster: Use Preview

Agent Roster Report

As you are modifying, you can also view your results with 
the “Print Preview” tool (magnifying glass).
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2. Agent Roster: Select and Sort Experts

Each Tab is a Selection on a Field

Sort is first by the Office ID ( a group section)
then by agent Last Name
and then by agent First Name

You can change the sort using the “Remove” and 
“Add” buttons - e.g. sort by start date:

Sort Expert
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2. Report Options Recommendation
A key setting recommended for each report is the File menu -> 
Report Options… screen: set “Convert Date-Time Field” to “To 
Date”,  and uncheck the checkbox for “Save Data With Report”.
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2. Agent Roster: Sections and Fields

Detail 
Section

Page 
Header 
Section

Group(subtotal) 
Section
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2. Agent Roster: Sections and Fields

• In the report above, the report title and column headings are placed in the 
“Page Header” group. 

• The agent names, ID’s, start dates, etc. are setup for the report within the 
details section. For each Agent record selected, a details line is printed. 
This line can be modified in any way by deleting, adding or moving fields. 

• As illustrated above, database-table (e.g. Agent) fields are added with the 
menu command “Insert” -> “Field Object” -> “Database Fields”.

• Note that besides Database fields other field objects are: 
• formula fields - fields you build that are calculations
• parameter fields - fields that you create to prompt for selections (e.g. 

office ID)
• special fields - fields you can also use on the report (e.g. “Page N of M”)
• Text is added to the report (e.g. column headings) with the menu 

command “Insert” -> “Text Object”
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3. How to Modify Listing Production Reports

Typical Agent Written Listings Ranking



© Executive Systems - Production Reporting Course using Crystal Reports® 43

3. How to Modify Listing Production Reports

COMMON:
OFFICES
PROJECTS
PROPERTYTYPE

BUYERSOURCE
SELLERSOURCE
SOURCEOFBUSINESS

AGENTS:
AGENTS

FRONTOFFICE:
LISTINGS

LISTINGAGENTS
LISTINGCONTACTS

BACKOFFICE:
TRADE

COMMISSIONS
TRADECONTACT

Listing production reports access the FRONTOFFICE database’s LISTINGAGENTS 
production table and the LISTINGS demographics table.
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3. Listing Production Reports - Typical “Join”
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3. Listing Production Reports - Typical “Join”

• The tables are normally joined as shown above using the 
iListingIndex field from both tables. This can be checked, or 
changed, using the Database -> Visual Linking Expert.

• If data from the Agents.Agents table is needed, then join 
that table’s szAgentCode to the ListingAgents table’s 
szAgentCode field.
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3. How to Modify Listing Production Reports

calculation
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3. How to Modify Listing Production Reports

• In addition to having database fields placed in the report, calculations using formula 
fields are utilized also. An example of a formula field is the “@calclistvolume” field. 

• Formula fields are created from the Insert command -> Field Option then to the -> 
Formula fields group.
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3. Listing Production: Top N/Sort Expert...
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3. Listing Production: Top N/Sort Expert...

Another key feature in Crystal Designer is the ability to rank 
subtotals. 

• Question:  How are the agent totals sorted by the total units 
for example and not the agent’s code?  

• Answer:  To setup sorting by ranking, use the menu 
command Reports -> “Top N/Sort Group Expert…”. Here 
you can rank (sort) by any field that is subtotaled for the 
group (e.g. units or volume in ascending or descending 
order).
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3. How to Modify Listing Production Reports
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3. How to Modify Listing Production Reports

• Crystal Reports Designer is to modify and build listing production reports. The above 
report, branchranklistwrittenbyunits, is a typical ranking report. 

• Note that the Details section applies to each ListingAgents record. These records are 
not printed in the report as you can observe by the section being darkened (grey). 

• The Group #2 totals all records by agent (ListingAgents.szAgentCode) and this level 
is printed - white color for this section.  The detail records are actually subtotaled to 
obtain each agent’s total listing and volume production.  (Groups, or Subtotal levels, 
are added using the menu command Insert ->  Group…)

So why is the Listings table included?      There are a couple of reasons:
1. The production report is for a certain office and listing date range - so the 

Listings.szOfficeCode and  Listings.dtListing field is needed by the select expert. 
2. The property address was desired for the Details section. Note that the Details section 

is not printed in the report but you can enhance your reports by allowing the “drill-
down” feature for the section. This means that a user can click on a report preview of 
a Group #2 agent record in this case, and then observe all properties that made up 
the production total.



© Executive Systems - Production Reporting Course using Crystal Reports® 52

4. How to Modify Sales Production Reports

Typical Agent Written Sales Ranking



© Executive Systems - Production Reporting Course using Crystal Reports® 53

4. How to Modify Sales Production Reports

• A typical sales production ranking report is shown above. Key 
production figures include:

• GCI: Gross Commission Income
• AGCI: Adjusted GCI - the amount of income received by the 

company after referrals are paid.
• Off-Top/Franchise: the fees paid to franchises and/or allocated to 

costs of doing business
• NAGCI: Net AGCI = AGCI less Off-Top
• Agent Gross: the agent gross earnings
• Company Dollar: NAGCI less Agent Gross
• Agent Net: net agent commission after transaction fees
• Trans Net: Company Dollar plus agent transaction fees
• Units: awarded units (sides, legs)
• Volume: awarded volume
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4. How to Modify Sales Production Reports

COMMON:
OFFICES
PROJECTS
PROPERTYTYPE

BUYERSOURCE
SELLERSOURCE
SOURCEOFBUSINESS

AGENTS:
AGENTS

FRONTOFFICE:
LISTINGS

LISTINGAGENTS
LISTINGCONTACTS

BACKOFFICE:
TRADE

COMMISSIONS
TRADECONTACT
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4. How to Modify Sales Production Reports

Sales production reports access and compute totals of fields 
in the COMMISSIONS table. This table is joined to the 

TRADE table for property, date and status information.
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4. Sales Production Reports: Typical “Join”
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4. Sales Production Reports: Typical “Join”

• Production reports are setup joining the Commissions and Trade tables 
using the iTransactionID field from each. Depending on the report 
selections, joining in one direction may be faster than the other. Test the 
reports to determine which way is better. 

• It appears that if the report is selecting data for a selected agent or office 
in a large multi-office company, the above direction Commissions to Trade
is best. If a companywide report is selecting a short production time 
(dates are in the Trade table) then joining from Trade to Commissions may 
be faster.
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4. How to Modify Sales Production Reports
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4. How to Modify Sales Production Reports

• The sample report branchranksaleswrittenbyAGCI is shown above loaded 
into the Crystal Reports Designer. The page headers contain the title and 
column header information. 

• The details section is hidden from printing and has the property address 
and statistics from each Commissions record. 

• The Group #2 subtotals by agent. This section is printed and the allocated 
income and commission are totaled and then ranked with the Top N/Sort 
expert. 

• The key production calculated fields are included in this report. Many 
customers use this report as the basis for others so that the calculations 
can easily be used without having to re-define them.



© Executive Systems - Production Reporting Course using Crystal Reports® 60

4. Sales Production Reports: Tips
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4. Sales Production Reports: Tips

• A key field in the Trade table is the transaction status. This field is a code 
field and the above defines the meaning of the codes 2 through 6. 

• For reports that report the status of each transaction, you should create a 
formula field that displays a meaningful description for each code.

• A formula field @statusdescription is included in the report file. The 
expression to assign the description is shown in the box above having the 
“If” and “else” statements. 
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4. Sales Production Reports: Tips

Edit
(right click)

Formula to 
assign status 
description

You can view how this 
formula is entered 
using the Insert drop 
down. 

Select “Field Object”,  
expand the Formula 
field list and right click 
the “statusdescription”
field and click “Edit”
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4. Sales Production Reports: Tips

A key field in the Commissions table is the iTypeID.  Like the status field in the Trade table, this is a code field having certain 
values assigned by BOS to designate the kind of record.
The above table defines the meaning of the iTypeID codes. For agent production ranking, the select expert would always select 
only records where iTypeID is 35. (35 also used for old misc check payment).
New reports might select other codes, for example, a report totaling referral fees would select iTypeID = 15.
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4. Sales Production Reports: Tips
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4. Sales Production Reports: Tips

• This illustration defines how all of the production figures are calculated 
from the Commissions table fields. 

• Shown are the two agent commission entry screens and surrounding are 
the field names that are used to store the entered items. 

• Also defined are various calculations where both sides are combined for 
totals and how company dollar is calculated. 

• Note that for GCI, AGCI, NAGCI and Company Dollar, the entries made on 
the “Allocated Gross” tab are very important. 
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5. How to Build New Reports

• So far we have covered how to modify existing reports. When you want to 
build a new report, there is the option of copying an existing report and 
modifying it. If the new report is similar or accesses the same tables, this 
can save time. However, other times it may be easier to start a new report 
from scratch. The following pages step through how to do this. 

• Use the Crystal Reports, File -> New command and use the Report Expert.

• The Database button is used first.
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After clicking the 
Database button, 
you will be 
presented with 
an explorer 
window from 
which you select 
the “ODBC”
source. 

Next, select the 
first database 
that your desired 
table is in - e.g. 
BackOffice.

Then, select 
each table you 
require by 
highlighting and 
clicking “Add”.
“Close” when 
completed.
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At close, you will be 
presented with the Visual 
Linking Expert and it may 
have attempted to join the 
files for you and perhaps it 
has created too many 
links.

If this is so, first, use the 
“Clear Links” button and 
then re-draw (drag from -
to) and create the links and 
directions you desire.
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After establishing your links, you need 
to select at least a couple of fields for 
your report. We recommend only a 
couple because it is easier to complete 
your report within the Designer after 
exiting the Report Expert. 

Click “Finish” to exit the expert.
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5. How to Build New Reports - New Name
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5. Report Options Recommendation


